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Account Management Tool Customer Release Notes

Preface
General Purpose
The Account Management Tool provides a central point to administer accounts
and users and track print, copy and scan usage for several Accxes based printers.
The Account Management Tool application is compatible with Windows®, Mac
OS®, Solaris™ or GNU/Linux operating systems.
Beginning with Accxes firmware version 7.5, the media usage (job accounting) of
multiple printers is tracked through the Account Management Tool (AMT), or
some other external accounting server. This replaces the functionality of the
Accxes Client Tools (ACT) Accounting Tab, which becomes disabled when ACT
is communicating with a printer that is using Accxes firmware version 7.0, or
greater.
WARNING: It is critical to first save media usage data from the printers’
controllers before loading version 7.0 or greater Accxes firmware, or the data will
be lost.
The pre 7.0 Accxes firmware accounting data can be saved by using one of the
following techniques: the pre-7.0 Web PMT Accounting page, the Accxes Client
Tools' Accounting Tab, the individual DST that existed prior to the Accxes Client
Tools, or the data can be saved to a removable storage device. See the Xerox
FreeFlow Accxes Printer Server Drivers and Client Tools Software Installation
Guide.

FreeFlow Accxes AMT Customer Release Notes

v

FreeFlow Accxes

This page left intentionally blank

vi

Account Management Tool Customer Release Notes

1 What’s New in 14.1
AMT

1

Language Pack Updates
The “Language…” selection located under the ACT File menu gives the user the
ability to customize languages for the client tools. The language packs are
installed from ACT, but will also impact AMT.

General Cleanup (minor bug fixes)
The AMT code has had some minor bug fixes added.

Compatibility with Mac OS X 10.6
(Snow Leopard)
AMT has been modified to run correctly on Mac OS X 10.6 with out dialog
corruption.

Branding Updates
The installer and the about boxes have had a Xerox branding update.
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2 Release Notes

2

Uninstalling Account Management Tool
Both AMT and ACT are uninstalled at the same time if they reside on the same
workstation. In Windows, they are removed by selecting “Accxes” on the
Add/Remove Program Properties screen. In Unix®, they are removed in the
AccXES/UninstallerData directory. To preserve your current AMT raw job
accounting database, the data files will remain in the AMT database folder after
the uninstall. This database folder will be listed on the Uninstall Complete
screen. The .lib and .bin files that also appear on the Uninstall Complete screen
are erroneously listed. This is because they have already been deleted in a
previous step of the Uninstall. See the Accxes Account Management Tool
Administrator’s Guide for details on uninstalling AMT.
Uninstalling on Mac OS X: In cases where AMT has been installed on Mac OS X
with aliases (shortcuts) located on the Dock, uninstalling AMT may not remove
the alias from the Dock. Simply drag the alias to the trash to complete
uninstalling AMT.

Installing Account Management Tool
It is recommended that the AMT should be installed on only one workstation.
Both the Accxes Client Tools and the Account Management Tool can be installed
during the same installation process. A password is needed for installing AMT. If
a password is not entered on the “Enter Password” screen, the “NEXT” button is
pressed to continue with installing only the Accxes Client Tools. See the Read Me
file, or the Accxes Account Management Tool Administrator’s Guide for
installation details.
NOTES:
• Because of the additional media types, the current AMT cannot load
TALLY tables from versions prior to 8.0. The tallied database can be
regenerated from the Raw Job Accounting Database. However, if you
want to preserve your current Tallied Database, you must save it to disk
(with a unique file name) before installing AMT.
•

If you want to install another language version of the ACT- AMT
application to the same directory, you must first uninstall the existing
ACT- AMT application.

Account Management Tool Customer Release Notes

2-1

FreeFlow Acxes

Microsoft® Windows Vista® Installation
Notes
By default, Windows Vista will virtualize all attempts to write in "C:\Program
Files\AccXES\" to
"C:\Users\<CurrentUser>\AppData\Local\VirtualStore\Program Files\AccXES\".
It is possible to access these files without changing any settings by simply typing
the location in to the Windows Explorer location bar. The "AppData" folder is a
hidden folder, so it can not be browsed to by clicking through with the mouse
unless Hidden Files and Folders are shown.
This is a new security policy in Windows Vista that falls under User Accounts
Control(UAC). The security policy can be found and modified at:
Control Panel->Administrative Tools->Local Security Policy->Local Policies>Security Options->
The two Security Policies that need to be changed are:
User Account Control: Run all administrators in Admin Approval More
User Account Control: Virtualize file and registry write failures to per-user
locations
If both of these policies are set to disabled before AMT is installed for the first
time, then the database files will be written to the normal location at C:\Program
Files\AccXES\AMTdatabase. (The system MUST be restarted before changes to
these policies will take effect)
To switch to this behavior after AMT has been installed and used, you will need
to back up the database files then completely remove AMT. Next, change the
security policies, and reboot the system. You can then install AMT, and copy your
database files to the normal location.

Memory Requirements for Global
Associations
The maximum number of AMT records allowed is: 9999 accounts, 9999 users,
999 printers, and 12,000 associations. An association is a combination of an
account, a user, and a printer.
NOTE : If you are running AMT under Microsoft Windows and you plan to
utilize the maximum number of associations, you must set the virtual memory on
your system to a starting minimum value of 300 MB.
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If AMT is going to reach its associations limit, a popup message will warn you
that the associations cannot be created. You could then delete unused or obsolete
accounts, users, or printers in the database to reduce the number of associations as
well as the associations themselves. When an account, user or printer is deleted,
any associations that reference that account/user/printer are deleted.
AMT on Mac OS X: When using this combination it is recommended that you
have a minimum of a G4 processor with Panther 10.3.3 or greater and Java 1.4.2
or greater. The Panther and Java updates are available via Apple’s Software
Update.

Printers Tab – Purge Needed Checkbox
If you press the button on the Printers Tab to resend the “purge” command to the
printer, the checkbox may remain in the Purge Needed column. If so, select View
> Printers to reset the checkbox to be blank, which indicates that the data was
successfully purged in the printer’s controller job log file.

Tallied Data
•

Using 256 MB of memory, tallying the database could take up to 1 hour if
there are 10,000 associations.

•

Because of the additional media types, AMT 11.0 cannot load the 8.0
version’s TALLY tables. The tallied database can be regenerated from the
Raw Job Accounting Database. However, if you want to preserve your
current Tallied Database, you must save it to disk (with a unique file
name) before installing AMT 11.0.

•

For certain large databases, the Generic Account does not get sorted
correctly and ends up in the middle. The rows above and below the
Generic Account row are sorted correctly.

Saving Data to a Disk
When the tally or raw data is written to disk, if a file of the same name already
exists an alert pops-up and says: "Do you want to replace existing file?" Instead
of replacing the file, it appends to the existing file. Give each file a unique name
to avoid this.
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One Location for AMT
It is best to use just one AMT application, from one machine. If you try to run
more than one AMT application at the same time, from the same machine, both
applications will lock up. If AMT is loaded on more than one machine, then you
risk loosing data if you interact with the same printer from the multiple AMT
locations.

Data Corruption
It is important to do a manual backup of the AMT database files on a regular
basis. The names of the AMT database files are: AccXESjadb.backup,
AccXESjadb.data, AccXESjadb.script, AccXESjadb.properties. In the Windows
environment, the default location of these data files is C:\ Program Files
\AccXES\ AMTdatabase. If you accidentally corrupt or delete the saved AMT
data files, they cannot be recovered. Your manually backed up files would then
need to be copied into the AMT database folder.

Importing Data
Pre 7.5 Accxes generated data:
• The import data file must be a .txt file.
•

Scan to net area Legacy accounting data cannot be imported. This is
because it is in square area that was scanned (dm), while the new job
based accounting displays scan to net data by file size (KB).

•

When importing Legacy accounting data, all printer names will be listed
as UNKNOWN.

Non-Accxes Controller Generated Data
AMT will only import an ASCII text format file containing account and subaccount/user identifiers, no binary code, and no control characters except CRLF
(Carriage Return Line Feed). See the Import section of the user guides for details
of the acceptable format within the ASCII file.
NOTE: In AMT 8.0, if account or sub-account identifiers were greater than 32
characters, the first 32 were imported. Beginning with 9.0, these identifiers will
not be imported at all. They will be reported as errors.
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Data Values
If "metric units" is selected as the Display Units on the Job Accounting Options
dialog, the raw database units are square mm and become square dm in the tallied
database. If "English units" is selected, the raw database units are square inches
and the tallied data is in square feet.
In the raw database, which shows on the Printer Job Accounting Tab, if multiple
media sizes, or media types, are used for the same print job, the data for only one
is shown in the Media Type column cell. It is the first value read from the Accxes
controller’s job log file. The AMT has no control over the order in which the
Accxes populates the job log file. However, you can double click on the Media
Type table cell to reveal the data values for all of the media types that were used
in the same print job.

Exporting Data
After exporting the raw or tallied data, the same data will be exported during the
next export of data, if the records are not first deleted from the databases, via the
Printer Job Accounting Tab. You should also export data before the Raw Job
Accounting Database’s keep interval (default 30 days) is reached, which will
cause the raw database records to be deleted the next time that you retrieve data
from the printers’ controllers.

Data Records Retrieved from Deleted
UserIDs or AccountIDs
It is recommended that the AMT Administrator retrieve the printer controller’s
job log file data first before deleting users or accounts in the AMT. If not, the
existing job log file data will still be copied to the AMT Raw Job Accounting the
next time that you retrieve data from the controllers.

Displayed Records Disappear
When displaying the database records, either raw or tallied, they will seem to
disappear if the ‘Job Accounting Options’ dialogue is opened.
To re-display the records simply press either the ‘view’ or ‘view tallied’ button.
Account Management Tool Customer Release Notes
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Miscellaneous
If you want to install another language version of the ACT- AMT application to
the same directory, you must first uninstall the existing ACT- AMT application.
When a user specifies that a job be folded, the job is logged as "Folded" even if
the fold job does not complete the fold process.

Unix and GNU/Linux
Default Shortcut Location
The default shortcut location is the home directory for Solaris and GNU/Linux. If
you want to create a shortcut to a specific folder, when prompted to do so during
the installation process, be sure that the folder exists. If it doesn’t, although the
installation will be successful, the shortcut will not be created because the folder
doesn’t exist. Also, make sure that you have permissions to install in the desired
location.

Shading Can Cause AMT to Freeze
Using the Window Shade feature on an AMT window can cause the application to
freeze. The operating system is not affected, and the application can be closed
and restarted to correct the problem.

Installation Error Using openSUSE® or Ubuntu GNU/Linux
Platforms
Verify the latest patch set has been applied to the workstation prior to installation.
The following error is invoked when running the installer on the openSUSE
(10.3) or Ubuntu (7.10) platforms. This error is purely informational and is
regarding the installer VM.
Launching installer...
libxcb: WARNING! Program tries to unlock a connection without
having acquired a lock first, which indicates a programming error.
There will be no further warnings about this issue.
libxcb: WARNING! Program tries to lock an already locked connection,
which indicates a programming error.
There will be no further warnings about this issue.
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Installation Error Using Fedora® GNU/L:inux Platform
Verify the latest patch set has been applied to the workstation prior to installation.
The following error is invoked when running the installer on the Fedora (8.0)
platform. This error is purely informational and is regarding the installer VM.
Configuring the installer for this system's environment...
Launching installer...
Locking assertion failure. Backtrace:
#0 /usr/lib/libxcb-xlib.so.0 [0xb5613777]
#1 /usr/lib/libxcb-xlib.so.0(xcb_xlib_unlock+0x31) [0xb56138d1]
#2 /usr/lib/libX11.so.6(_XReply+0xff) [0xb4012f]
#3 /tmp/install.dir.3079/Linux/resource/jre/lib/i386/xawt/libmawt.so
[0xb521022e]
#4 /tmp/install.dir.3079/Linux/resource/jre/lib/i386/xawt/libmawt.so
[0xb51eeed7]
… (rest of error truncated for readability) ….

Use of Desktop Effects
When running the FreeFlow Account Management, Tool Desktop Effects must be
disabled. The interaction between Desktop Effects and the Account Management
Tool prohibits the use of drop down menus. If drop down menus do not activate
during the use of the FreeFlow Account Management Tool, it is recommended to
verify this feature is disabled.

Umlauts
Labels containing umlauts may not print correctly from AMT when running under
GNU/Linux.

Mac OS X
Minimum Requirements
When using AMT with Mac OS X it is required that you have a minimum of a G4
processor with Mac OS X 10.4 or greater, Java® 1.4.2 or greater, and a screen
resolution of 1152 x 870 or greater. Ignoring these recommendations will result
in unreliable operation of AMT on OS X. The Mac OS X and Java updates are
available via the Apple software update.
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